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A. New Wind Tunnel Component.
Confirm Autodesk CFD 2019 Ultimate is installed.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 7.

Step 8.

Step 9.

https://www.autodesk.com/
education/free-software/cfd-
ultimate

Open your BODY RAIL
FORM file.

Right click the top node the
BODY RAIL FORM As-
sembly &j in the Browser
and select New Compo-
nent, Fig. 1.

Rename New Component

Tunnel D, Fig. 2.

Expand Sketches folder and
Show 'ﬂ' Sketch7 (sketch
created in Render Chapter),

Fig. 3.

Expand Construction folder,

right click Plane2 n'—-l
(Plane created in Render
Chapter) and click Create

Sketch | i | from menu,

Fig. 4. =

On the Sketch tab ﬂ

click Create Menu > Rectan-
gle > Center Rectangle |:|

Click Front on View Cube
)

Sketch a center rectangle,
Fig. S.
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Step 10.

Step 11.

Step 12.

Step 13.

Step 14.

Fusion 360 V2 CFD FLow Sim

Click Midpoint A in the
Constraints panel of toolbar
and click bottom endpoint
of vertical line in Sketch?7
and bottom horizontal line,
Fig. 6.

Click Dimension (D)

on the toolbar. o

Add dimensions, Fig. 7.

Click R?lght View on View Fig.6 N\

Cube | riGHr

)—‘ ' ~

Switch Visible 7

Style to Wireframe

(Ctrl-7). To switch L

to Wireframe, click

the Display Settings

pull-down in the 430 i
Navigation Bar at the
bottom of the canvas P I\
= (@ .

and select Visual N7 e

Style > Wireframe,

Fig. 8. e S

220
Fig. 7

Visual Style » Shaded Ctri+4
Mesh Dizplay > Shaded with Hidden Edges Ciri+5
Environment > (@ Shaded with Visible Edges Only  Cirl+6
Effects » Wireframe Cirl+7
Object Visibility » Wireframe w'rt‘iidden Edges Cirl+8

GBI Q-

Camera [ 3

Wireframe with Visible Edges Only Cir+3

Ground Plane Offset
f&] enter Full Screen
- B
Fig. 8
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Step 15. On the Solid tab _SPLID ¢lick Extrude L"[ (E). © EOmFEATURE
— y

Profile k 1 zelected B

Step 16. In the Extrude panel set, Fig. 9 Start |+ offset Pane ‘ -
Profile click rectangle, Fig. 10 Offset 150 mm~ -
Start Offset Plane I —+ Direction iy One Side ‘ -
Offset -150 Extent | Distance .
Direction One Side .[;E] Distance 52000 mm ~ -
Distance 520 Tapersngle 0.0 deg .
Operation New Body [:ﬁ Operston () New Body .
click OK. ~

[i ] OK Cancel
Proﬁle\ Fig. 9
N\
S =2

[ Ip

e

Fig. 10
S
Step 17. Click Home m (Isometric) on View Cube .
X
Step 18. Switch Visible Style to Shaded with visible Edges | Veuaisve P|  Shaced Criv4
Only (Ctrl-6). To switch to Wireframe, click the uesnDspay Bl Shaded wih Hidden Edges _ CirS
Environment P|  Shaded with Visible Edges Only geetri6
Display Settings @ pull-down in the Navigation Effects M| @ viierame .
Bar at the bottom of the canvas and select Visual 2”““‘“"“ : reframe i fidden Edges -GS
Style > Shaded with visible Edges Only, Fig. 11. | =L "' issess o ers
Enter Full Screen

¢-6vae BE s
Fig. 11
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B. Appearance. o APPEARANCE

¥ Apply To:

Step 1. Display the Appearanceupanel, use A key.

Bodies/Components @

Step 2. In the Appearance Panel: Faces o
under Library, Fig. 12.  In This Design

click Glass —~ —~

expand Smooth DBl O
drag Glass(Clear) onto Tunnel, Fig. 13.
click Close. ! m D

* Library

| Seardh Q |

c Fusion 360 Appearances | &% My Appearances Favorites

] Glass
£ Color Density
7] Smooth

| " > | )
| Glass - Window

. Glass (Blue)

' Glass (Bronze)

[i] Close
C. Ground Tunnel and Hide Sketch. Fig. 12
Step 1. Right click Tupnel D n b o) w2 Pop——— Y
B.rowser and click Ground, D © (J WASHERv2QMirron:1 4 © ST e
Fig. 14. D @ [) WASHERv2(Mirror):2 D % Document Setiings ‘
D © () EcLPv4(Miror):1 D i Named Views
Step 2. Expand Sketches folder and b e 8 el D @ orgn
. . D ® E CLIP v&{Mirror):3 [ ® M loints
Hide €&P Sketch7, Fig. 15. 7 = - ~°"" """ —
|> L D FRONT WHEEL v5{Mirror):1 A © FN Sketches
Step 3. Activate @ BODY RAIL D © (0 REARWHEEL v2(Mirror):1 & sketent
FORM Assembly @, Fig.15. D © (J @ evescrewvi & sketcn2
D ® () & EYESCREWVI2 4 sketchs
Step 4. Save. Use Ctrl-S and press i z AR —
I_A c
ENTER. = —
~ 4 sketchs
<$> Move/Copy M ]_i Sketch?
[ New Companent D o Cnnstruciiuns
EﬁCreateDrawing P G o
Fig. 14 Fig. 15
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D. Simulation Workspace.
Confirm Autodesk CFD 2019 Ultimate is installed.
https://www.autodesk.com/education/free-software/ctd-ultimate

Step 1.

Step 2.

Step 3.

Switch to the Simulation workspace. To switch, click Design

Workspace toolbar and click Simulation

In the New Study dialog box double click Simplify

New Study

=
B
N
\

SIMULATION ~

B

Simplify geometry for use in Simuistion

Static Stress Modsl Frequencies

{1 lre

Structursl Buckiing Nenlingzr Static

Stress

Help me choose a study type.

Fusion 360 V2 CFD FLow Sim

Thermal Thermal Stress
AR
Event Simulation Shape Optimization
(Preview)
Fig. 16

DESIGN ~

in the Change

from the menu.

, Fig. 16.

Simplify
Choose "Simplify..." to clean up your CAD model for simulation,
or select a study type from the left and "Create Study”. You
can also choose to simplify your model after you've created a
study.

Simplify Model | Cancel
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E- Simplify- +« BROWSER Ll
Step 1. In the Browser expand Model Components folder and Hide #EI 4 85 smuston oces

L i
Bodies " folder 4 @ ——
Blank D component D B8 NamedVisws
both Eye Screw D components b EmEEO
Tunnel D component, Fig. 17. (show Tunnel after Combine) 4 |>- anm:::ms
[ Cunstru%
Step 2. On the Simplify Solid tab D (D BLaNKvi s
| @ COMBINE o D © (] FRONTAXLE v\
S o LD click Modify Menu > Faraet Body Iy 1 selected D @ () carsoDvt
. i _ @ D © (] WASHER v2:1
Combine . Tool Bodies I .
Operation .Juin A L T e e e
Step 3. In the Combine panel set, Fig. 18 New Component 0 5 8 :z zzz::; N
Target Body click car body, Fig. 19 Keep Tools @ P ® @ Carmcevi: S
Tool Bodies drag selection around | b o @ rumqeus
all other components, Fig. 20 (3 Fig. 17
click OK. Fig. 18

N

Target body.
RN

«« BROWSER el
Step 4. In the Browser, Show 'ﬂ' Tunnel D component, Fig. 21. 4 fy  Simulation Hodels
4 o FETTTITTING
Q Units: mm
> B8 MNamed Views
b3 Bl Origin
4 Bl Wodel Components
b3 il Bodies
D © @Bl Construction
>3 () BLANKw1:
D © (] FRONTAXLEv3:1
D © (] carpBoDY:1
D © (] waASHERv2:1
M am (Tl wrscucn.an
B T
>3 [ EYE SCREWv1:1
>3 () EvEscREWwv12
D © (] CcARTRDGE w11
D © (] TunneLa
Fig. 21 '
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F. Launch CDF.
On the Tools tab w click Simulate in CFD ﬂ: on the toolbar.

Step 1.

Step 2.

Step 3.

Step 4.

In the Design Study Manager dialog box click the Path Lj icon, Fig. 22. Select a folder
to save CFD files. Back in the Design Study Manager dialog box, click Launch.

In the Geometry Tools dialog
box on the Edge Merge tab
[ EdgeMerge \ click Merge, Fig. 23.

L Design Study Manager *

Mew design study Update design study

Study name:  [BODY RAIL FORM

Design name: |Design 1

Scenario name: |Scenari0 1 |

Click the Small Object tab
A Small Object L, Fig. 24 Study path: | =
drag the Tolerance slider to ~
right until the Remove button is e Cancel
highlighted, around .00200488 Fig. 22
click Remove and Close <.
L Geometry Tools hd L Geometry Tools X
{ Edge Merge "\/"Small Object \/ Void Fill \/” Ext. Volume "\ { Edge Merge "\/" Small Object oo Void Fill \/” Ext. Volume "\
Edge merging Small object removal ‘
Merge edges whose induded angle is Highlighted entities
less than (degrees): EI O (7 surface ® .’(‘ Edge
Edges to b d: 42 M Tolerance:
QES I ) :EFQE b 4 IE]‘ Drag the slider to identify entities to remove,
2 Di
Display edges to be merge l
@ Undo Display objects to be remm&
Object smaller than minimum
Surfaces: 0
Edges: 8 Remove ‘
@ Undo
Fig. 23 Fig. 24
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G. Setup.
Step 1.

Step 2. Click the Tunnel outline and click Edit j in the
pop-up, Fig. 26.
Step 3. In the Materials dialog box:
confirm Name Air, Fig. 27
click Apply.
Step 4. In the Design Study Bar:
under Material, Fig. 28
right click Unassigned and

click Edit from menu.

Step 5. In the Materials dialog box:
set Type Solid, Fig. 29
ABS is OK.
click Apply.

Design Study Bar g X

Right click the Tunnel and click Outline from the menu, Fig. 25.

Selection list

Select all
Deselect all

? &

Previous

Group

Shaded
Outline
Transpa r&

Favorites

aoQ

Make favorite

Selection: Volume

»

@

Name Air
Environment Set..&

Fig. 25
ﬁ Click Tunnel
Materials n
Property settings
Material Edit...
Material DB Name Default
Type Fluid

Remove
Fig. 27

Cancel

—I Note
@, Design 1
L) Geometry (cm)

v E Scenario 1

v & Material
v &b Air [Fixed]

[ 1 TUNNE
[ 2 TUNNE 7
[ 3 TUNNE
*J Boundary Cond
] Initial Condition
5 Mesh Size
&, mMotion () shaded
& Groups Outline
v = Solve Transparent
=+ Flow: On
== Heat Transfe 9. Show

Fig. 28

Collapse

Edit.,

= Remow

Suppress

Fusion 360V2 CFD FLow Sim

Materials

Property settings

Material Edit...
Material DB Mame Default

Solid

Name ABS (IPQged)
Environment Set..

Fig. 29
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H. Boundary Conditions.

Step 1.  On the Setup tab | sefup | click Boundary Conditions - dary in the Setup Task panel of

toolbar. Conditions

Step 2. Click the front surface of Tunnel outline and click Edit E in the pop-up, Fig. 30.

Step 3. In the Boundary Conditions dialog box:
Velocity Magnitude 75 (m/s), Fig. 31
click Apply.

Boundary Conditions n
Property settings

Type Velocity

Unit m/s

Time Steady State

Method Mormal

Direction Reverse Normal

Spatial Variations Constant
Velocity Magnitude

@ Remove Cancel
Fig. 31

surface

@

Step 4. Click top right corner on View Cube %ﬂ to rotate view to view rear face of Tunnel.

Step 5. Click the rear surface of Tunnel outline and click Edit E in the pop-up, Fig. 32.

Step 6. In the Boundary Conditions dialog box:
Type Pressure, Fig. 33
confirm Pressure 0
click Apply.

1368401

Boundary Conditions n
Property settings

Unit Pa

Time Steady State
Pressure 0

Gage / Absolute Gé

Static / Total Static

Remave Cancel

Fig. 32

surface
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Tlp: If the SOlver falls L Solver Computers and Configurations x
unselect use Cluster
Computers
on Solver Computers
and Conﬁgurations Solver Computer or Configuration  Computer or Head Node Name Cores Use Cluster Motify
’ MyComputer DESKTOP- 3 Ol O
To unselect Cluster, s
click Simulation menu MyComputer (Scalable Solver) DESKTOP- 3 O
CLOUD CLOUD 0
> Solver Comput- = =
ers and uncheck Use CLOUD Premium CLOUD 0 O O
Cluster Of Mycom_ *** Click to odd o computer..*™
puter, Fig. 34.
@ Move down oK Cancel
I. Solve. Fig. 34

[o]a]e]

Solve n
Step 1. On the Setup tab | setup | click Solve ii IN control _ physics  Adzptation

the Simulation panel of toolbar. SolutiWMode Steady State
Save Intervals
Solver Computer MyComputer
. Conti Fi 0
Step 2. In the Solve dialog box on the Control tab terations to Run Ry :
Control , Fig. 35,
Set Iterations tO Run 130 Solution control Result quantities S
click Result quantities button. “ ] solve
Fig. 35
Step 3. In Result Quantities dialog box set:
under Basic flow values, Fig. 36
uncheck Temperature
under Turbulence
check All button
under Miscellaneous
check Pressure coefficient
uncheck Wall heat flux
and Wall ﬁlm I Result Quantities x
coefficient
. Basic flow values Turbulence Miscellaneous
Clle OK Velodity Turbulent kinetic energy [ wall forces
Pressure Turbulent energy dissipation [ absolute velocity
Step 4. Back in Solve dialog box L] Temperature Effective viscosity [J Absolute static pressure
’ . [] scalar ‘ Effective conductivity [ vorticity
click Solve. Wall model y+ [ Strain rate
Wall shear stress Pressure coefficient
Turbulent intensity e aTs ‘
Al Mone Al Mane [] Temperature gradient
Fluid properties Compre$ W e
Density [ Mach number L] Local mean age (LMA)
|:| Viscosity |:| Total pressure D Wal heat flux Options...
[ conductivity [ Total temperature [ wall fim COEfﬁdEﬂt‘
Factors...
[ Spedific heat [ Thermal comfort
Parameters...
[] smoke visibility
Al None Al None Al Mone
(] Cancel

Fig. 36
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Step 5. In the Output Bar the mesh starts calculating, Fig. 37.

Qutput Bar

Initializing ...

Control file processing complete

Chedk Out motion License:  Successful

Authorization verified

Processing input ...

Mesh input complete

Processing results input ...

Results input complete

Processing BC input ...

Computing restart BC data ...

Calculating BC data structures ...

Calculate wall distance for 271840 fluid nodes

Wall distance calculation done in {0 + 2) seconds, Max distance = 6.68582
BC data structures complete and saved

Analysis Initislization Complete

Input processing complete

** FINITE ELEMENT SUMMARY FOLLOWS...

381079 Total Modes, 271840 Fluid Nodes , 109239 Solid Nodes
1659065 Total Elements, 940533 Fluid Elements , 718532 Solid Elements
1Inlets 10Cutlets 0 Unknowns

““““““ AMALYSIS STARTED s

Turbulent Incompressible Flow is OM W

\_Message Window \_Convergence Plot /
Fig. 37

Step 6. After the mesh is calculated CFD will switch to the Convergence Plot tab
\_Convergence Plat / and start generating curves. When the curves converge or flatten out the
analysis is complete, Fig. 38.
The analysis could take several minutes depending on your computer. While the analysis is
running we will create a plane.

Output Bar
Plot \/” Table Global e
Iteration #130 Vx Vel —— Al -
vy Vel ——
vzvel —— |Avg hé
Pres Log scale
/ Temp ——
TKE
yd -
TED ——
Scalar
1 130 Save...
start: [1 | End: [130 @
\_Message Window /\_Convergence Plot!‘
Fig. 38
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J. Create Plane.

f! 6401

Step 1. Right click the Tunnel and click Outline
from the menu, Fig. 39. Global result R
Global vector 3
Step 2. On the Results tab | Results Vectorsettings..
() Shaded
@ Cutline!
click Planes Flanes in the Re- g I:rn;f::?
sults Tasks panel of toolbar. @ Shaded mesh
Set transparency...
Step 3. Click Add '#::j in the Planes z::: :tl,t )
panel of toolbar. Show texture...
Hide
: Fig. 39
Step 4. Click Edit 55? Edit in Planes panel of &
toolbar.
Step 5. In the Plane Control dialog box:

On the Controls tab = Cn0s  gig. 40

The Plane should be on the Y axis and centered on the Tunnel, Fig. 41

To position Plane on Y axis, click Normal button
In the Edit plane normal dialog box, Fig. 42
set X 1 and click OK.

Back in the Plane Control, set Appearance Transparent

Plane Control

Controls ‘b\ecmr settings

36401

0.23

\

Result: | Velodty Magnitude
Position

82003
Point on plane | 0, 20.8, 5.74
41001
Move {
I 0.5

5nap|0.00 %
Normal ., 0, -1.49E-07
Rotahe~

Rotationaxis | 0, 1,0

Save table...

'_@J Appearance: gTransparent "4
Grid spacing ‘

Fine Coarse

| 101 | [5.41 |

0.0682

Fig. 40
C Edit plane normal 7 X
X E‘ | ¥ [o |z [o
Cancel

Fig. 42
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Step 6. Click Right on View Cube "

Step 7. In the Plane Control dialog box set:

Click the Vector setting tab ‘=cter settings
Results Velocity Vector
drag the Length slider to around .4
Click More button
Arrowhead size .15
Scale factor .1

, Fig. 43

Plane Control n

Controls Vector settings
Results Velocity Vector ‘ -
Length ‘
(@) Same length () Length range
Min I -0.402661
@ More,
Attributes ‘

Show arrowheads
Arrowhead size| 0,15

Scale factor|0. 1 ‘
[ Filtering ‘

Min i} Reset
Grid spacing drag slider to around 1 Max |12413.2
click Close . Save table...
It_‘)) Appearance: @Shaded -
Grid spadng
Fine Coarse
0.0682 1.01‘J 3.41
f Fig. 43
36401
R S e e S e G I T S o S S e e S VN U N WA S S P S Y S S
~ L e e T e e
g3 —» » » » LR R ] o > r ” b g > > b PR S . - > I >
——p e b P PR e e e i e J: —
B e A e e o S R S S S S S R S e S i — = e e —
B0 e e S e i - R o S T S e L | I
P P e

—_— 77>:L e =,
Cr SR

Step 8. On the Results tab | Results| click Static Image
lad Static Image - in the Image panel of toolbar and same im-
age. Also, save a Dynamic Image [Gg Dynamic Image .

K. Hide Plane.

)
s
Step 1. Click Home {h (Isometric) on View Cube .

Step 2. In the Design Study Bar:
under Planes, Fig. 45
Hide [_] Plane 1.

Fusion 360 V2 CFD FLow Sim

Design Study Bar g X

_ Mote

[ Design 1

b Geometry (cm)

v @ Scenario 1

o Material
% Boundary Conditians
#) Initial Conditions
&5 Mesh Size (auto)
4 Motion
& Groups
= Solve
v &% Results
@G Parts
v @ Planes
[0 @ Plane 1((1) Velocity
& Points ‘
& 150 Surfaces
% 150 Volumes
“* Traces

Fig. 45
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L. Hide Coordinates Axes.
Step 1. On the View tab View | click Axes k. Axes: = inthe Appearances panel of toolbar, then
uncheck Show Bounding Coordinate Axes.

M. Drag Coefficient.

Step 1. On the Results tab Results | click Wall Caleulator y,, in the Results Tasks panel of

toolbar. Calculator
Wall Results n
Step 2. In the Wall Results dialog box: Zﬂ;:z::;:ﬂzn ot
Click Select All " to select all (all edges red), Fig. 46. ~ C @wime © Fsurface " e
Unselect the Tunnel by selecting the six surfaces. v X KO Group operaton: v
To unselect: ! “
1) click the 3 surfaces visible in Iso view - 3 edge will be s
displayed unselect blue, Fig. 47. : .
[ Force dyne *

[ cutoff pressure

A | o (B

[ Pressure dynefan2 =
[ Temperature Celsiuz *
[ Heat flux W=
[ Film coeffident W fem2K = W
Ref. temperature: 300 | |Celsius * W
Use near-wall temperatures
[ Torque dyne-cm * e
Torque axis
Point on axis |0.0, 0.0, 0.0
Direction |0,0,1
@ Calculate
Fig. 46

W -

2) Click top rear corner of View Cube %w to rotate.
i

v

3) Click bottom front corner of View Cube : to rotate.

4) Click the 3 remaining surfaces, Fig. 48.
(Tunnel edges blue)

Tip: Red edges selected
Blue edges unselected
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Step 3. Still in Wall Results dialog box:
check Force, Fig. 49 Wall Results [« |
set unlts Newton Selection and Result  Qutput
. Model entity selection
click Calculate O (@ volume  ® [T Surface 7 Edge
. L SRR < Group operation: ﬂ -
click Output tab ©utPut - - .
Fig. 50 :
scroll down to bottom a
under Summary ; v
FY (drag) 5.48 —
FZ (lift) .87 0 cuofferse
}{ [ Pressure dynefcm2 *
Close . [] Temperature Celsius *
[ Heat flux w*
Step 4. Save. Click Save E on the L fimcosffent e
. Ref. temperature: 300 | |Celsius *
Qule ACCGSS TOOlbar Use near-wall temperatures
[ Torque dyne-cm *
Torgue axis
N - Tra ces. Paint an axis 0.0, 0.0, 0.0
Direction |0,0,1
Step 1. Click Home {i} (Isometric) g Ca@m‘
Fig. 49

W
on View Cube @ .

X

B
| Results | click Traces Taces 10 the Create Set panel of toolbar.

Step 2. Click Look At @ in the
Navigation Bar on left edge
of the canvas, Fig. 51.
Step 3. Click front surface of Tun-
nel, Fig. 52.
Step 4. On the View tab
click Axes le. Axes: = j
the Appearances panel of
toolbar, then uncheck Show
Local Coordinate Axes.
Step 5. On the Results tab
e
Step 6.

Fusion 360 V2 CFD FLow Sim

—

&/

T

e

Wall Results

Selection and Result Cutput

Center of Force about ¥-Axis 052 30299, 0. ~
Center of Force about Z-Axis (X-Y), 230141, 11

BOUNDARY ID, 1

Area, 0.0433413, cm”2

sum FX, 0.000161999, Mewton

sum FY, 3.88332e-05, Newton

sum FZ, 4,27304e-06, Newton

Center of Force about X-Axis (¥-Z), 11,4694, 0.
Center of Force about Y-Axis (X-Z), 2.4, 0.6201
Center of Force about Z-Axis (X-Y), 2.4, 11.498

Total area, 306.351, cm”™2

TOTAL FX, 0.0136773, Newton

TOTAL FY, 5.27295, Newton

TOTAL FZ, 0.855395, Newtonk

Center of Force about X-Axis L, 303073, 1.1
Center of Force about ¥-Axis (X-7), -0.0048545!
Center of Force about Z-Axis (X-Y), -0.0008451: v

< >

View file...

|Write to ﬁle...l

Fig. 50

In the Create Set panel of toolbar set Seed Density 1.4, Fig. 53.

Seed Type: | Rectangular - EEj
. | Grid -
Seed Pattern: | Gri ndd
Seed Density: | 1.4 =
| V. Create Set |
Fig. 53
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Step 7. Click Add % in the Create Set panel of toolbar.

Step 8. Click left of the wheel at
ground level to start the
pattern. Click to right
of other wheel and click
up above the top of car
body, Fig. 54.

Tip: The seed of pattern | . . . . .

can be moves by dragging R

an arrow head of the triad,

Fig. 55. .

1st click _ -

Step 9. Click Right View on N,

RIGHT

View Cube
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Step 10. On the Results tab | Results | click Edit #” Edit in the Modify Set panel of toolbar.

Step 11. In Edit Trace dialog box set: ZdittT'miEt' e H
under Properties, Fig. 57 -

Trace ID Residence time (sec) ~
Appearance Spheres ! 1 07790-02
Width 75
. 2 6.8177e-03
click Close.
3 6.0910e-03
—~ 4 5.8320e-03
a% 5 57301e-02 &
Step 12. On the Results tab Results | click Edit 4.zt in the Pro- v T
cess Traces panel of toolbar. Color
(®) Results | Velodty Magnitude A
Step 13. In Animate Traces dialog box set, Fig. 59 O soid 0
Animation Tlme 8 Properties
Cth Play h- Appearance: Sphel'es~ hd
. Range: Full range -
click Play > o Stop —_— o -
click Save avi Steps: |5000s :
Close }'{ [ Mass Mass properties
Step 14. Save. Click Save E on the Quick Access Toolbar. © lose
Fig. 57

q':"\ kL VL e p——
(oo e < s
.

8 g e ® © 0 ©
8 ;¢ ¢ 0 0 0

Animate Traces n
“ 4 r_1Ir M
Animation Time (sec) | & ‘

Save avi...

Fig. 59
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